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PRESIDENT’S PAGE
Welcome to any New Members and Guests who may be with us for our March Monthly Meeting.

Your Committee has been hard at work in the last month on an application for a grant which, if we are
successful, will enable us to broaden our ability to help more of our community via our teaching
programme.

We have arranged some very interesting speakers for future meetings, on topics that may be a big help to
anybody thinking of up-grading their printers, scanners or venturing into Digital Cameras. We will
certainly have a chance to see the latest developments in these areas which should help when making your
decisions.

Unfortunately we still have some members on the sick list and to them we send our best wishes for a
speedy return to good health, we are thinking of you and miss you at our meeting.

Our News Editor has had a worrying time with his Computer in the last several weeks; it’s one of those
unusual series of calamities that at present are really taxing our Mr. Fixit,but knowing how he reacts to any
challenge, I'm sure Jim will find a way. It’s amazing how a new language seems to spring up when
nothing goes right and even more amazing how swearing at the Computer sometimes achieves marvellous
results. [ just don’t know how that works.

I have spoken to the Church Authorities about how we are becoming slightly cramped for space for our
meetings, they have offered the Main Church Hall as an alternative. To do this we would have to purchase
a Digital Projector and some form of P/A System.. Currently theses items are almost within our reach, so
the Committee will give serious thought along these lines; another stumbling block is we would have to
change our Meeting Night because the Church Choir meet for practice on Wednesday evenings. As they
say in the classics ‘Watch this Space’.

To our ‘Birthday Babes’ for this month we say, ‘A Happy Birthday’. If it is a male member, maybe his
wife will buy him the new Computer he’s been hinting about. For the female member perhaps you will be
able to get that gorgeous dress you saw when shopping last week.. Stranger things have happened...but
first up I think you have to believe in Fairies.

Don't forget we, (your Committee) are always looking for topics for our meetings and if you have any
particular subject or programme you would like to know more about, just speak to a committee member.

THOUGHT FOR THE MONTH
Be quick to take advantage of an advantage.




TIPS

Computer email Info!

Very useful when trying to read small print (especially in the early hours). If you hold down the
Ctrl key on your key board and then turn the small wheel in the middle of your mouse away from
you or towards you, the print size will change - it will either get larger or smaller - depending on
which way you turn the wheel.

Lost the Volume control icon?

How to get back the little speaker icon that used to be in the bottom right corner of the screen (the
system tray).

They never seem to know how it disappeared, but you can bet it was an over-zealous mouse drag
by one of the kids or something like that. To get it back:

From the Start menu, go to Control Panel

In Windows XP:

Choose Sounds and Audio Devices,
(if you're in Category View, open Sounds, Speech, and Audio Devices first)
On the Volume tab, tick the box: Place volume icon in the taskbar.

In Windows 2000 and Me:

Double-click Sounds and Multimedia;
On the Sounds tab, tick the box: Show volume control on the taskbar.

In Windows 98:

Double-click Multimedia,
On the Audio tab, tick the box: Show volume control on the taskbar.

Then click OK, and the speaker icon will reappear in the system tray!

nb:  Double click it to get to the advanced options.
nb2: If the icon still doesn't appear, take the tick out of the 'show on taskbar' box, click Apply,
tick the box again and click Apply again.

'% ‘ YA
MEETINGS ’ TOPICS
March 15th Konica & Minolta Digital Cameras Stuart Evans.
April 19th File Format for MP3 John Lethbridge.
MEETING RULES
NO SMOKING NO DRINKING NO SWEARING

We are allowed to use the facilities at Christ Church, O’Halloran Hill in return of a small fee plus respect for
their property. We ask for your co-operation in respect to the above. While we cannot control what our
members do away from our club meetings, piracy of copyright material cannot be condoned at our meetings




Southern Districts Computer Users
Club Inc.

MEETINGS are held on the third
Wednesday of the Month at:-

The Christ Church O’Halloran Hill
1708 Main South Road O’Halloran Hill
at 7.30pm

Visitors most welcome.

Cost $2 per family, which includes the
Newsletter plus coffee/tea and biscuits.

Subscriptions for twelve months $18
Novice and experienced computer users will
be warmly welcomed

For further information about
S.D.C.UC.IL

Contact The Club President,
Ron Stephens
8387 2814

Correspondence to
The Secretary
S.D.C.U.C.L

Box 991
Morphett Vale 5162
Email to
stephens@tadaust.org.au

The salesman set the computer up on the
executive’s desk at W.F Fotheringham & Son.
“This is the latest technology, Mr Fotheringham,
ask it any question even a personal one.

”The executive was sceptical, “OK” so he typed
in:" Where is my father?" The answer came back,*
Your father is playing golf at Royal Melbourne."
That's wrong.” said the executive, “My father died
5 years ago." The salesman was surprised, but not
flustered as he typed in:" Where, exactly is Mr
Fotheringham Senior?”The answer was prompt.
“Mr Fotheringham senior died 5 years ago, but
Bill Fotheringham’s father is still at the seventh
green at Royal Melbourne.”

Acre Avenue DVD
Shop 6 42 Acre Avenue Morphett Vale
Latest Releases
2 Day and Weekly Hires

Rent any movie for only $3.50

Every Day Special RENT 3 Movies for only $8

Free Booking service

We also remove scratches from DVD’S and CD’S
Phone cards and starter kits available
Open 7 Days Sun, Mon, Tue, Wed 11 am. 8 pm.
Thurs, Fri, Sat, 11 am. 9 pm.

The Art Of Speech
In a speech about Hurricane Rita, President Bush declared, quote,

“This is a big storm.”

In related news, the White House announced earlier today that the president is writing

his own speeches.

What has Microsoft done to increase the stability of Internet Explorer?

Microsoft is continually stress-testing Internet Explorer to find and fix any stability problems that may exist. In
addition, the new crash-reporting feature of Internet Explorer 6, fault collection services, has allowed us to more
accurately pinpoint problems experienced in the browser, both by our development team and by early beta testers.

As Internet Explorer 6 is more broadly used, crash reports from users will play an even more important role

in increasing Internet Explorer's stability. Internet Explorer 6 SP1 is the latest release to Internet Explorer 6
Microsoft




OUTLOOK EXPRESS, Security and housekeeping tips

Preview Pane: if you use the default setting that includes the preview pane under the
messages list in your Inbox, there is a risk of some virus or Spyware infection. Turn it
off:

Open Outlook Express, (offline ok)

Left click on the “View” tab above the toolbar

From the drop-down menu, choose “Layout”

On the Layout Panel, untick the box “show preview pane”

Click on the “Apply” button and then OK

Close Layout panel, preview message will not be downloaded and displayed
next time you access your mail inbox.
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When the preview pane is open, the mail message has to be opened. Some viruses or
Spyware can exploit this feature.

Deleted Items: When you clean up your Inbox and other folders, you use the
“Delete” Button on the toolbar, (red cross). This action simply transfers the mail into
the “Deleted Items” folder. Unless you empty this folder on a regular basis, the files
will still be there taking up drive space. You can set Outlook Express to automatically
delete these files on exiting the program:

e Open Outlook Express,
Left click the “Tools” tab above the toolbar
On the drop-down menu, select “Option” right at the bottom
From the Options Panel, choose the “maintenance” tab
On the “Cleaning up messages” pane), tick the box against “Empiy Messages
Jrom ‘Deleted Items Folder” on exit”
Note the other options for future reference.
Click “OK” and the files will now be deleted when you exit Outlook Express.
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This feature will permanently delete the messages so be sure before you send any mail
to the “deleted items” folder.

Receipts: Outlook can be set up to ask for a receipt to be sent from a recipients PC.
You might also get messages that ask for a receipt too. To control this function:
e Open Outlook Express
o Left click the “tools” tab and again select “Options” at the bottom of the drop-
down menu
s Select the “Receipts” tab
Choose the option that you would like from the panel. Tick the box to request
a receipt or untick not to request. Select the referred Radio Button at the lower
pane to decide how you deal with receipt requests. | prefer the “Notify Me... "
Option. Again, click on “Apply” and “OK” to finish.

While you have the “Options” menu open, have a look under the other tabs for
Security, Connections, and Signatures etc; to learn a little more about Outlook
Express.

CC 2006

Many thanks to Colin Campbell for this item
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‘ Active X Controls

Active X Controls are rules written in
a variety of computing languages,
Automotive Repairs that let the programmes share data.

2 &\ ALL GENERAL Controls are often used to Display
d) MECHANICAL REPAIRS | | special content, such as multimedia,
Brakes, Suspension, Clutch, in the Microsoft Internet Explorer
Auto Trans Service, browser.
‘ . Wheel Balance & Repairs,
an New & S/Hand Tyres. Active X controls provide functions
similar to Java applets but rely on the
Pensioner SERVICE, TUNE & SAFETY Windows operating System.
& Seniors CHECK
. (most 4 & 6 cyl cars) - Includes Whereas applets are meant to be a
Discount plugs, points, oil, filter. cross-platform for operating systems.

U4/2 Somerset Circuit
Lonsdale SA 5160
Ph/Fax: 8186 0081
Stephan Bielawski

Proprietor

VCSWEB
Established 1991

0422 912 583
Web Design Hosting Domain Names

Personalised Service
http://vesweb.com
eBay Sales
We have great items for gifts such as Playstation & Gameboy accessories, phone covers,
wheat bags, laser pointers, chess sets and more.
Buy online and pick up locally!
http://www.stores.ebay.com.au/vcswebgoodiesbox/

We can also sell items for you.
Contact us for details!

Opinions expressed in this newsletter do not necessarily represent those of the Southern Districts Computer
Users Club Inc. nor does publication of an advertisement imply endorsement by the Southern Districts
Computer Users Club Inc.

While every attempt has been made to verify that the information in this newsletter is correct, the Southern
Districts Computer Users Club Inc accept no responsibility for any inaccuracies.

Likewise no member of the committee or member of the Southern Districts Computer Users Club will
accept any liability for any damage occurring to a computer or to any computer systems from following
instructions given in this newsletter.




Computers and More
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Brightness Graphics Terminal

Browser Harddrive Videocard

Chipset Internet Webpage

Club Isp Windowsxp

Computer Keyboard

Contrast Microprocessor

Dial Microsoft

Disk Modem

Dos Monitor

Download Motherboard

Drivers Mouse

Email Ram

Explorer Spreadsheet

Files Spyware

Thank you Colin for this brain-teaser

Copy Deadline for the April Issue of our

Newsletter is Tuesday 11™ April 2006




Acre Avenue Delicatessen
Shop 1 42 Acre Avenue Morphett Vale

More than your normal Delicatessen.
We are a Super Deli offering hot fish and chips, bacon and egg sandwiches, video hire,
bus tickets, newspapers, magazines, postage stamps, selected small-goods, and a wide
selection of dairy foods, and household items
To offer you the best of services we are open from
7.00 am to 7.00 pm seven days a week

Come on in, meet Sue & Shane and their friendly staff.

Acre Avenue Deli. The Friendly Deli  Ph. 8384 4004

To insert a symbol into a Word document

ie. f£v@® B XEXN BO

Insert a symbol

=X

You can use the Symbol dialog box to

enter symbols that are not on your keyboard,.

Insert a symbol pml e > 2DORACID 2o kAR 2R
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1. Click where you want to insert the symbol.

2. On the Insert menu, click Symbol, and then click the Symbols tab.
3. In the Font box, click the font that you want.

4. Double-click the symbol that you want to insert.

5. Click Close.

Ask-Us Consultancies Pty Ltd
ABN 81 073 496 732

Trading as

R.J. Williams & Associates

ROD WILLIAMS Frpna

* Public Accountants * Reg. Tax Agent * Business Management
e Computing * Marketing

40 Acre Ave., Morphett Vale SA 5162
Ph (08) 8326 7111 Fax (08) 8326 7110 Mobile 0408 827 789
E-mail: askus @esc.net.au




Spyware and Adware

Are little annoying programs that find their way onto your computer via your internet surfing.
These nasty little programs will watch your surfing habits in order to display relevant
advertising to you. They slow down your computer and are about as necessary and helpful as
a virus— ie: NOT.

Install Spybot and Adaware. (Or similar protection)

Once installed, use the link in both programs to download the latest updates, then run Spybot
first. Reboot, then run Adaware.

Both programs will recommend that you remove any issues they find, and you should take
that advice (they backup what is removed, so it's pretty safe!)

If you're running Windows, you should visit the Windows Update site to get all available
patches and updates.

In Outlook, Ctrl + Shift + E creates a new folder. Good for a bit of housekeeping! And while
you're at it, you can select a random group of emails by holding down the Ctrl key while you
click them. To select a group - click the first email, then Shift + click the last one in the group.

(Windows Key brings up the Start menu without using the mouse).

Email Hoaxes and Net Nasties - How to spot them !

Here are a few tips to help you determine which of the 'too good to be true' emails you
should delete. Whatever you do, DON'T forward them to anyone... you'll be adding to the
unnecessary email traffic around the globe.

(1) Does it SOUND feasible? If a Nigerian prince is offering to transfer $5 million into your
bank account and offering to give you some of it, you can safely delete that without
worrying you'll miss out on a windfall. It's a hoax.Bill Gates isn't ever going to send you
money for forwarding an email to your friends, either. Sorry!

(2) Is it asking for PERSONAL information? There are lots of very clever emails now that
look like they are from eBay,

PayPal or even your own bank asking you to confirm or change your password. Have you
received one? It's a hoax.eBay, PayPal and all of the Banks have confirmed that they will
NEVER send out requests for your personal information. The best way to check
authenticity is to go to your Internet browser, go to the site in question and log in the usual
way, checking for any messages from the site itself. NEVER, NEVER, NEVER click a link
in an email like this - you'll be taken to a pretend website, lulling you into a false sense of
security, where you'll enter your personal details, un-knowingly giving them to a stranger.
The link below will help you determine whether the email you've received is a hoax. Do
your research before you forward it to anyone.

Find out more about email hoaxes at -

http://netforbeginners.about.com/od/emailhandbook/a/hoax_confirm.htm?nl=1




